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Welcome
Congratulations on bringing Maurice into your lab! We welcome you as a new user and are excited to be a 
part of your work. This user guide will provide you with details on system hardware, operating the system, 
how to use Compass for iCE software, maintenance procedures and other useful information.

To help you get the most from you new lab addition, we've added some attention phrases to guide you 
through the user guide: 

NOTE Points out useful information. 

IMPORTANT Indicates information necessary for proper operation of Maurice systems.

CAUTION Cautions you about potentially hazardous situations that could result in injury to you or 
damage to the system.

!WARNING! Warns you that serious physical injury can result if the listed precautions aren•t followed.

Maurice Systems
Maurice, Maurice C. and Maurice S. systems give you identity, purity and heterogeneity data on your biolog-
ics, and get you to results faster with short development times and simple workflows!

€ They're fluent in cIEF and CE-SDS. They take cIEF up a notch, and CE-SDS is a breeze. You'll get pI 
and charge heterogeneity data in less than 10 minutes flat „ with the added bonus of same-time 
absorbance and native fluorescence for sensitivity down to 0.7 µg/mL. Their size applications have 
the high res and wide molecular weight range you need and they're done in 35 minutes. 

€ They make it easy. Just pop in a ready-to-go cartridge, drop in your sample vials or a 96-well plate, 
and hit start „ they'll do the rest! 

€ They're time-savers. Develop methods fast so you get to results even faster. Your cIEF and CE-SDS 
methods are done in a day. The icing? You can develop platform methods and use them for multiple 
molecules. No maintenance and clean-up needed between the two applications. 

€ They're dependable. Get reproducible results with tight CVs day in and day out. Your data is reliable 
no matter what „ across samples, users, instruments or labs. 
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Introduction
This chapter will help you prepare the lab for Maurice. Please have the space, electrical and environmental 
requirements ready prior to scheduling your installation.

NOTE: Please wait for an authorized ProteinSimple Field Service Engineer to unpack and install Maurice 
for you. Don•t try doing this yourself. Handling Maurice incorrectly could cause injury to yourself or dam-
age to the system.

Space Requirements
You need a lab bench or table that can support 100 lb (46 kg) and has enough space for both Maurice and 
his computer. There should be sufficient clearance for both heat ventilation and to provide access if Maurice 
needs service.

IMPORTANT 
Maurice needs a stable surface and must remain level to work properly. The lab bench or table can•t 
shift or wobble under heavy weight. Don•t use anti-vibration tables either, since Maurice may not 
stay level while he•s working.

Recommended space requirements for Maurice. 

Dimension Meters Feet

Width 1.5 5.0

Depth 0.8 2.5

Height 0.5 1.5
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Physical Specifications 

For indoor use only. Use up to altitudes of 1524 meters (5000 feet).

Table 2-1: Physical Specifications

Electrical Requirements 
Maurice requires a dedicated, grounded circuit capable of delivering the appropriate current and voltage for 
your country. The power requirements for all three Maurice systems are 100 V- 240 V (AC), 50/60 Hz, 500 W.

In addition to these requirements, Maurice needs the grounded circuits terminate at the receptacles, and 
receptacles must be located within 10 ft (3 m) of the instrument.

Environmental Requirements
Maurice likes a consistent temperature in the lab (not too hot … not too cold). He works best when condi-
tions stay within these ranges: 

Table 2-2: Environmental requirements. 

Description Specification

Maurice•s Dimensions (Door Closed) 0.44 m x 0.42 m x 0.61m (H x W x D) 
1.46• x 1.38• x 2.0• (H x W x D)

Maurice•s Dimensions (Door Open) 0.44 m x 0.57 m x 0.61m (H x W x D) 
1.46Ž x 2.43• x 2.0• (H x W x D)

Maurice•s Weight 46 kg (100 lb)

Computer Workstation Dimensions 0.41 m x 0.66 m x 0.76 m (H x W x D)
1.35' x 2.17' x 2.49' (H x W x D)

Requirement Specification

Operating temperature range 18 - 25 °C (64 - 77 °F)

Operating humidity range 20-80% relative, non-condensing
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Software and Computer Requirements 
Maurice brings his own computer to the lab with Compass for iCE software pre-installed. Compass for iCE is 
used to run cIEF and CE-SDS applications on Maurice and analyze resulting data. Just in case you need it, a 
CD containing Compass for iCE software also comes in the box. If you don't want to analyze your data at 
Maurice's workstation in the lab, Compass for iCE software can also be installed on a separate workstation, 
such as your desktop computer. Your computer must meet the recommended requirements listed below to 
run Compass for iCE software and process data.

Table 2-3: Computer requirements.

General Guidelines and Information 

Intended Use 

NOTE: Maurice is for research use only. Not for use in diagnostic procedures.

Lifting and Moving the System: Lift Maurice Correctly

IMPORTANT 
Take all the standard precautions when lifting or moving Maurice. Since Maurice systems weigh 46 
kg (100 lb), you should not lift him by yourself. Two people should lift him onto the lab bench. 

Component  Recommended

Operating System Windows 7

Processor Core i5

Memory 6 GB

Free Disk Space 100 GB

Ethernet Ports 2 - One is required to connect to Maurice, the other is 
used for network access

USB Ports 2 - To connect the keyboard and mouse
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Maurice Systems
Maurice, Maurice C. and Maurice S. systems include the instrument, computer workstation, Compass for iCE 
software and cIEF or CE-SDS Cartridges.

All systems have the same hardware components, computer and software, the only difference between 
them are the applications you can run:

€ Maurice: cIEF and CE-SDS applications

€ Maurice C.: cIEF applications only

€ Maurice S.: CE-SDS applications only

You can run samples in 96-well plates or in up to 48 sample vials with integrated 0.2 mL inserts on all three 
systems.

Maurice with Computer Workstation cIEF and CE-SDS Cartridges

Maurice C. Maurice Maurice S.
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External Components

!WARNING!  
You can•t replace or service any parts on Maurice systems except for the power entry fuse.

System Door

Maurice's door gives you access to the inside of the instrument to load cartridges, reagents and samples. To 
open the door, first make sure the status light is a steady blue. Then just touch the metal touch plate on the 
top of the door to open it. Close it by pushing the door until you hear the latch engage. 

NOTE: Maurice•s door must be closed before starting a batch. 

Touch Plate to

System Door

Status Light

Open Door
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Status Light

The LED on Maurice•s front panel tells you what he•s doing. Here•s what his different status lights mean:

€ Start-up (magenta): You've just turned on the power and Maurice is warming up. 

€ Ready (steady blue): Maurice is powered on and ready to go. 

€ Opening Door (long blue flash followed by blue pulses): Maurice•s door is opening.

€ Running (pulsing blue): Maurice is running a batch. 

€ Trying to Open Door While Running (red flash): Maurice•s door can•t be opened when he•s run-
ning.

€ Error (steady red): Maurice has detected an error. To get more information on the error, check the 
Status pane in the Run Summary Screen in Compass for iCE.

Internal Components

Cartridge Slot

The cartridge slot holds Maurice•s ready-to-go application cartridges. The cartridge it holds depends on the 
system: 

€ Maurice: cIEF and CE-SDS Cartridges

€ Maurice C.: cIEF Cartridges only

€ Maurice S.: CE-SDS Cartridges only
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The lights on either side of the cartridge slot will be orange after Maurice disengages the cartridge when 
the door is opened at the end of a batch, and whenever the slot is empty. 

The lights change to blue once a cartridge is installed correctly.

NOTE: You can find cartridge prep, installation and post-run procedures in Chapter 7, •Running cIEF Appli-
cations on Maurice and Maurice C.• and Chapter 8, •Running CE-SDS Applications on Maurice and Mau-
rice S.•

Cartridge
Slot
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Sample and Reagent Platform

Maurice•s sample and reagent platform has two rows for batch reagents. These reagents are kept at room 
temperature. 

€ Row P (top): These reagents are loaded under pressure during the batch. Only use glass reagent 
vials with pressure caps in this row. Use blue pressure caps with cIEF reagents and orange pres-
sure caps with CE-SDS reagents.

€ Row N (bottom): Only use reagent vials with clear screw caps in this row.

The sample block holds either a 96-well plate or 48-vial metal insert and is temperature-controlled. You can 
set it to 4 °C, 10 °C, 15 °C or turn the temperature control off in Compass for iCE software. 

Sample cooling turns on when the run starts, and takes a few minutes to reach the temperature setting. 
After a run, the sample block stays at the set temperature until you open Maurice•s door, then it shuts off 
until you start the next run. This prevents excess condensation. 

NOTE: Because Maurice holds the sample block temperature after a run until you open the door, samples 
are still viable for your next run and after overnight runs.
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NOTES:  
When you•re using a 96-well plate, well A1 should be in the top left corner of the insert. 
 
You can only use V-bottom plates with the 96-well plate insert. 
 
Remove plate lids before inserting a 96-well plate into Maurice. 
 
You can find info on where to load reagents and samples for cIEF applications in •Step 4: Load Samples 
and ReagentsŽ on page 90 and for CE-SDS applications in •Step 4: Load Samples and ReagentsŽ on 
page 124. 

96-well Plate
Insert

48-vial
Insert
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Rear Panel

Located on Maurice•s rear panel is the power entry, power switch and network connector. 

€ System Power - The main system power components consist of the power input, fuse and power 
switch

!WARNING!  
Only use the power supply cord provided with Maurice. If the cord is damaged, please contact Pro-
teinSimple Technical Support.  
 
!WARNING!  
You can't replace or service any parts on Maurice except the power entry fuse.  
 
!WARNING! SHOCK HAZARD 
Disconnect the power cord from Maurice•s power input to disconnect power to the instrument.

€ Network connection - A 10/100/1000 Mbps Ethernet (RJ-45 connector) is used to connect Maurice 
to a computer or local network.

NOTE: Serial numbers are used to identify individual instruments. 

System Labels

A full system label is located on the rear panel. It includes the ProteinSimple location, system model, power 
requirements, serial number and certification markings.

Power
Entry

Power
Switch

Fuse

Network
Connector
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A serial number label is located on the Maurice system•s front lower right side, on the silver system base.
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Computer Workstation
The PC has two built-in Ethernet ports, one is used for Maurice and the other is available for your company•s 
network. ProteinSimple configures one port to have a fixed IP for a local link connection to the instrument, 
the other is configurable by users and will typically use a DHCP for dynamic IP.
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Chapter 4:  
Compass for iCE Overview
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Launching Compass for iCE

Compass for iCE Overview
Compass for iCE has three main screens: 

€ Batch - You•ll create and review your batch.

€ Run Summary - Check out the status of your run.

€ Analysis - Take a look at the data from your experiment.

Each screen has these components: 

To open Compass for iCE, just double-click the icon on the computer desktop.

Instrument
Status Bar

Screen Panes

Title bar Screen Tabs

Status Bar

Main Menu



Compass for iCE Overview page 19

User Guide for Maurice, Maurice C. and Maurice S.

Changing the Screen View

To toggle between the Batch, Run Summary and Analysis screens, just click the button in the screen tab 
located in the upper right corner of the main window. 

Batch Screen

The Batch screen is used to create, view, and edit batches. You can assign samples to 96-well plate wells or 
vials, create and modify methods, customize your injection list and assign methods to each of your injec-
tions. 
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Run Summary Screen

The Run Summary screen is used to monitor status of a batch in progress, the CE-SDS separation or cIEF 
Focus series for each injection and the current and voltage plots for each injection.
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Analysis Screen

The Analysis screen is used to view data from your batch, including the graph view (electropherograms) and 
a table with your results. You can also analyze your data for completed runs. 
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Screen Panes 

Each of the Batch, Run Summary and Analysis screens have multiple panes that let you view the individual 
components of a batch, method or data file. Each pane has a labeled tab and a unique icon. We'll describe 
panes specific to each screen later in the individual screen sections. 

The active pane in a screen is blue. To view a pane, click in the pane or on its tab. The example below shows 
panes in the Batch screen, and the Graph pane is active:

Title Bar

In the title bar you will see the batch file name and the icons that allow the main Compass for iCE window to 
be minimized, maximized or closed.

Main Menu

Access to various software, instrument and screen operations is available through the main menu. More 
details on menu commands can be found in •Software MenusŽ on page 25.

Instrument Status Bar

The instrument status bar is used to start batches and cleaning protocols, indicate system status and show 
run progress. More details on instrument control and status can be found in Chapter 10, •Controlling Maurice, 
Maurice C. and Maurice S.•.
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NOTE: You will only see the instrument status bar when Compass for iCE is connected to an instrument. 
There is no status bar on computer workstations that you're only using for data analysis.

Screen Tab

The screen tab lets you move between Batch, Run Summary or Analysis screens and is located in the upper 
right corner of the main window. Just click a button to view a screen.

View Bar

The view bar is only displayed in the Analysis screen as part of the main menu, and allows you to switch 
between viewing standards or sample data, data for a single injection or all injections in the batch, or 
grouped injection data. View bar options are in •Viewing Run DataŽ on page 295 for cIEF applications or 
page 205 for CE-SDS applications. 

Compass for iCE Status Bar 

The status bar is in the lower right corner of the main window. It displays active software processes and their 
progress. 

Software Menus
Some of the items in the Compass for iCE main menu are available in specific screens only, and menu com-
mands change depending on which screen is active. You can find menus and commands available for each 
screen in the Chapter 5, •cIEF Batches•, Chapter 6, •CE-SDS Batches•, Chapter 9, •Run Status•, Chapter 12, •cIEF 
Data Analysis• and Chapter 11, •CE-SDS Data Analysis•.
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File Menu

The File menu contains basic file commands.

Edit Menu

The Edit menu contains basic editing commands, analysis and preferences options. Specific details on pref-
erences are described in Chapter 13, •Setting Your Preferences•. 
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View Menu

The View menu is only available in the Analysis screen, and allows you to change how your data is displayed. 
For more info on view options check out •Viewing Run DataŽ on page 295 for cIEF applications or page 205 
for CE-SDS applications, and •Using GroupsŽ on page 306 for cIEF applications or page 216 for CE-SDS appli-
cations. 

Instrument Menu

The Instrument menu is only available when the software is connected directly to your instrument. You can 
lean more about instrument control options in Chapter 10, •Controlling Maurice, Maurice C. and Maurice S.• 

Window Menu

The Window menu lets you to switch between the Batch, Run Summary or Analysis screens, and restore 
screens to the default layout. 

€ Batch - Displays the Batch screen where you create, view, and edit batches. 



page 28 Chapter 4: Compass for iCE Overview

User Guide for Maurice, Maurice C. and Maurice S.

€ Run Summary - Displays the Run Summary screen which lets you view the status of a batch in prog-
ress. 

€ Analysis - Displays the Analysis screen that lets you view electropherograms and results and change 
analysis parameters

€ Default Layout - Restores the individual panes in the current screen back to their default size and 
location. 

Help Menu

The Help menu gives you access to Help, software updates, release notes and other software info. 

€ User Guide - Displays the User Guide for Maurice, Maurice C. and Maurice S. 

€ Check for Updates - Automatically checks to see if a new version of Compass for iCE is available. 

€ Release Notes - Displays the software release notes for the current and prior versions.

€ Compass for iCE Log - Displays the software log file.

€ About Compass for iCE - Displays the software version and build information.

Changing the Compass for iCE Main Window Layout
You can easily resize the main window and the individual panes in each screen. Screen panes can also be 
moved outside of the main window. 

Resizing the Main Compass for iCE Window

To resize the main window, roll the mouse over a corner or border until the sizing arrow appears. Then just 
click and drag to resize. 
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Resizing the Screen Tab

The screen tab can be sized to show all or just some of the screen buttons. To resize, roll the mouse over the 
left edge of the tab until the sizing arrow appears, then click and drag to resize. If a screen button is hidden, 
a double arrow will display in the tab. Just click to display and select the hidden screen.

Resizing Screen Panes 

€ To resize a pane - Roll the mouse over the pane border until the sizing arrow appears. Then just click 
and drag to resize. 

€ To maximize a pane - Click the maximize button in the upper right corner or double-click the tab.

The other panes in the screen will automatically minimize to pane bars in the task area along the win-
dow border.
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€ To restore all minimized panes - Click Restore on the minimized pane bar.

€ To restore only one minimized pane - Click the pane icon on the minimized pane bar.

€ To restore a maximized pane to its original size - Double-click the tab or right click the tab and 
click Restore.

€ To restore all panes to their original sizes - Select Window in the main menu and click Default 
Layout.

Changing the Location of Screen Panes

Panes can be moved to different locations within a screen. 

€ To move a pane - Click on its tab and drag it to the new location. As the pane is moved, area guides 
will display to assist you in choosing a drop location.

Area guides with a black arrow let you know that if the pane is dropped at that location, it will 
be resized and relocated as an individual pane in that area of the screen. 

Area guides with a folder let you know that if the pane is dropped at that location, it will be 
added as a new tab in an area with one or more pane tabs. 
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This example shows the Analysis screen after moving the Graph pane: 

€ To detach a pane from the main window - Click on its tab and drag it outside the main Compass for 
iCE window or right click the tab and click Detached.

€ To move a detached pane back inside the main window - Right click the tab and deselect 
Detached.

€ To restore all panes to their original locations - Select Window in the main menu and click 
Default Layout.

Area guides with a window let you know that if the pane is dropped at that location, it will be a 
separate window outside the Compass for iCE main window.
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Restoring the Main Window to the Default Layout

To restore screen pane sizes and locations to the original Compass for iCE layout, select Window from the 
main menu and click Default Layout.

Software Help
Select Help and click User Guide to view Maurice Systems User Guide. 

Checking for and Installing New Versions of Compass for iCE 
The software can automatically check to see if a newer version of software is available. To do this:

1. Make sure the computer being used has an active internet connection.

2. Select Help and click Check for Updates. If an update is found, a screen will display with the new ver-
sion that•s available.

3. Click Finish to start the download and install the update. 

4. Follow the on-screen instructions to complete the software installation. 

5. Reboot the computer before using the new version of software.

Viewing Release Notes
Select Help and click Release Notes to view a PDF with feature updates and bug fixes for new and past ver-
sions of Compass for iCE. We recommend you review these notes whenever a software update is installed.

NOTE: You can contact ProteinSimple Technical Support to request the release notes for new versions of 
Compass for iCE before you install it. 
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Viewing the Software Log
Select Help and click Compass Log to view the software log file.

Compass for iCE Version Information
Select Help and click About Compass for iCE to view the software version and build number information.
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Directory and File Information
The main Compass for iCE directory is located in the Program Files folder, and also contains PDF files of the 
User Guide for Maurice, Maurice C. and Maurice S. 

Batch and run files are located in the Documents folder in the User directory on your computer: 

€ Batches Folder - Contains all batch files that you•ve saved.

€ New Batches Folder - Contains Maurice batch template files. 

€ Runs Folder - Contains all batch data files. Data is automatically written to this folder. 
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NOTE: When a Compass for iCE software update is performed, the template s in the New Batch folder are 
overwritten. If you have customized these batches, we recommend saving them in a unique subfolder 
prior to updating the software, then transferring them back to the New Batch folder after the update to 
avoid losing your customizations. 

File Types

These file types are used by Compass for iCE:

€ Batch Files - Use a *.batch file extension. 

€ Run Files - Use a *.mbz file extension. The default file format for run files is Date_Time_BatchName. 
An example run file name would be 2016-01-28_18-50-53_CE-SDS.mbz.

€ Analysis Settings Files - Exported analysis settings files use a *.settings file extension. 



page 36 Chapter 4: Compass for iCE Overview

User Guide for Maurice, Maurice C. and Maurice S.



page 37

User Guide for Maurice, Maurice C. and Maurice S.

Chapter 5:  
cIEF Batches

Chapter Overview
€ Batch Screen Overview

€ Opening a Batch

€ Creating a New Batch

€ Viewing Replicate Injections

€ Batch History

€ Making Changes to a Batch

€ Viewing and Editing Batches in Completed Runs

€ Batch Reports
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Batch Screen Overview
You can use the Batch screen to create, view, and edit batches. To get to this screen, click the Batch screen 
tab:

Batch Screen Panes

The Batch screen has five panes:

€ Layout - Displays a map of either the 96-well plate or 48-vial tray of batch sample locations.

€ Injections - Lists the injections, sample ID, sample locations and methods that Maurice or Maurice C. 
will execute for each sample in the batch.

€ History - Lists all batch file events from initial creation to the most current update. 

€ Notes - Lets you enter specific information about your batch. 

€ Methods - Lets you create methods and enter method parameters used in the batch.
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Software Menus Active in the Batch Screen

These main menu items are active in the Batch screen:

€ File

€ Edit

€ Instrument (when the software is connected to Maurice or Maurice S.)

€ Window

€ Help

File Menu

These File menu options are active:

€ New Batch - Creates a new batch from a starter template.

€ Open Batch - Opens an existing batch.

€ Save/Save As - Saves the open batch.

€ Batch Report - Exports a table of sample and method details for each injection in the batch as a PDF 
file. 

€ Exit - Closes Compass for iCE.
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Edit Menu

The following Edit menu options are active in the Batch screen: 

€ Cut - Cuts the information currently selected. 

€ Copy - Copies the information currently selected.

€ Paste - Pastes the copied information. 

NOTE: Cut, Copy and Paste work differently depending on the pane you•re in. How and when you can use 
them is described throughout the chapter. 

€ Plate Layout - Lets you select between a 96-well plate or a 48-vial tray to run samples in.

€ Default Analysis - Displays the default settings that will be used to analyze the data generated with 
your batch. 

€ Preferences - Lets you set and save your preferences for data export, graph colors, grouped data and 
Twitter settings. See Chapter 13, •Setting Your Preferences• for more information.
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Opening a Batch 
To open an existing batch:

1. Select File in the main menu and click Open Batch. 

2. A list of the last five batches opened will display. Select one of those or click Browse to open the 
Batches folder and select a different one.

3. To make changes to the batch, see the steps in •Creating a New BatchŽ on page 42. When you•re done, 
select File from the main menu and click Save. 
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Creating a New Batch 
To create a new batch, we recommend that you use one of the template methods and make any necessary 
modifications from there. 

Step 1 - Open a Template Batch 

1. Select File in the main menu and click New Batch:

NOTE: If you•re using a Maurice system, both cIEF and CE-SDS template batches are available in the menu.

2. Select Maurice cIEF. A batch using the default method will display. 
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Step 2 - Assign Your Samples

The Layout pane shows the default locations of where batch reagent should be placed in your Maurice sys-
tem•s samples and reagents platform, and a map of either the 96-well plate or the 48-vial tray used for sam-
ples.

The same reagent locations are used for every batch:

€ P1 - 0.5% Methyl Cellulose with blue pressure cap

€ P2 - Fluorescence Calibration Standard with blue pressure cap

€ P3 - Water vial with blue pressure cap

€ P6 - Empty vial (air) with blue pressure cap

€ N1 - Water vial with clear screw cap

1. To assign samples, select 48 vials or a 96-well plate depending on what you•re running. Clicking on the 
vial/plate icon toggles between formats. 

2. To select samples:

€ Add samples and select methods later: Use your mouse to highlight the well or vial positions 
your samples are located in, then click Add. For this example we•re using vials. 
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NOTE: The template batch automatically adds a sample in well or vial A1 by default, but if you don•t have 
a sample in this position you can remove it after you•ve added new positions for your samples. 

€ Add samples with preassigned methods: Highlight the well or vial positions your samples are 
located in, then right-click and select a method. 

Either option of adding samples populates the Injections table:
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To remove samples, just highlight the ones you want to remove and click Remove. They•ll also be 
removed in the Injections table. You can also right-click well(s) or vial(s) in the Layout pane and click 
Remove Sample(s). 

3. The sample platform is temperature controlled with a default setting of 10 °C. To change the tempera-
ture or turn it off, click the down arrow next to the temperature and select an option. 

NOTE: The two reagent rows are kept at room temperature. 
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Step 3 - Assign Your Method Parameters

NOTE: We recommend using the default method parameters. Please see the Maurice cIEF Method Devel-
opment Guide for more information on method optimization.

The Methods pane lists all of the methods used in a batch. You can add and remove methods here and 
change method parameters. 

1. In the Methods table, click the first cell in the Name column and enter a new method name if needed. 

2. Click the first cell in the Separation column, then click the selection button [...] to set the pre-focusing 
and focusing time (in minutes) and voltage (V).

€ To change time and voltage parameters: Just click in a cell under Time or Voltage and type 
the new value(s).

€ To add a profile step: Click Add. A new row will be added in the table. Then just type in a load 
time (in minutes) and voltage value (in V).

€ To remove a profile step: Select the row you want to remove and click Remove.  
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3. Click the first cell in the Detection column the selection button [...] to set your exposure times for 
absorption and fluorescence detection modes.

€ To change the exposure time: Just click in a cell under Exposure and type the new value(s) in 
seconds.

NOTES:  
The first exposure is an instrument default setting and can•t be changed.  
 
Fluorescence is the default detection for the remaining exposures and can•t be changed.

€ To add a profile step: Click Add. A new row will be added in the table. Then just type in an expo-
sure time (in seconds).

€ To remove a profile step: Select the row you want to remove and click Remove.  

4. Click the first cell in the Sample Load(s) column and set the load time in seconds.

NOTE: We recommend using the default Sample Load time of 55 seconds. Please contact ProteinSimple 
Technical Support if you have questions on the Sample Load time to use for your application.



page 48 Chapter 5: cIEF Batches

User Guide for Maurice, Maurice C. and Maurice S.

5. Click the first cell in the pI Markers column to select pI markers. Add new markers or remove existing 
ones then click OK.

NOTE: When you edit the pI markers in the method for a batch, Compass for iCE automatically creates a 
Markers group in the pI Markers Analysis settings for you.

€ To add a pI marker: Click Add. A new row will be added in the table. Then just type in a pI and a 
position (in pixels).

€ To remove a pI marker: Select the row you want to remove and click Remove.  

6. Optional: Click the first cell in the Ampholytes column and enter the ampholytes you•re using. 
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7. Optional: Click the first cell in the Additives column and enter any additives you•re using. 

8. You can now: 

€ Click New in the upper right corner of the Methods pane to add a new one if you want to use dif-
ferent methods for different samples. Then just repeat the steps above for the new method.

€ Make updates to the remaining methods by repeating the prior steps.

€ Select a method and click Remove in the upper right corner of the Methods pane to delete it.

Step 4 - Set Up Your Injections

The Injection pane lists all sample injections for the batch. Any samples that were added in •Step 2 - Assign 
Your SamplesŽ are automatically added to this list.

Selecting an injection in the table also selects the sample the injection will be made from in the plate or vial 
map in the Layout pane and vice-versa. 
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1. To add sample names, click the Sample ID cell for the injection and type a name. 

The sample name also displays when you hover the mouse over the sample in the plate or vial map:

2. Assign your methods to each injection. Just click the Method cell for the injection and select a method 
from the drop down menu. If you added your samples with pre-assigned methods and don•t need to 
make any changes, skip to the next step. 
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Hovering over a method name displays the method parameters:

3. You can add or remove injections as needed using a few different options. If you don•t need to make any 
changes here, just skip to the next step.

€ To add sequential replicate injections: Highlight an injection and click Replicate. A new injec-
tion will be added under the row you selected

€ To add injections at the end of the batch: Click on any sample position in the Layout pane or 
sample injection in the Injection table and click Add. A new injection using the same sample will 
be added to the end of the table. Assign the method if needed. 

€ To copy and paste injections: Right-click on an injection in the Injection table and select Copy. 
Click on the injection number above where you want to insert the copied injection, right click 
and select Paste. The copied injection will be inserted under the row you selected. 

Step 5 - Add Batch Notes (Optional)

1. Click on the Notes pane.

2. Click in the notes area and type any information you want to add about your batch.
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Step 6 - Modify Default Analysis Parameters (Optional) 

You can preset the parameters used to analyze data generated with the batch. We recommend using the 
default parameters for cIEF applications, but if you need to modify parameters:

1. Select Edit from the main menu and click Default Analysis. The following screen will display:

2. Change the parameters you want to, then click OK. For detailed information on analysis parameters, 
please refer to •Analysis Settings OverviewŽ on page 334.



Viewing Replicate Injections page 53

User Guide for Maurice, Maurice C. and Maurice S.

Step 7 - Save Your Batch

1. Once all of your sample, method and injection info is entered, select File > Save. Enter any comments 
on the batch if you want, then click Save.

2. Enter a name for your batch then click Save. 

Viewing Replicate Injections
Injections with replicates have an arrow next to the injection number. You can expand or collapse the list of 
replicate injections by toggling the arrow:

€ To show all replicate injections in the batch, click the Expand All Injections button.
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€ To hide all replicate injections in the batch, click the Collapse All Injections button.

Batch History
Clicking on the History pane shows the batch event history, starting with the date and time the batch was 
created through the most current event. Clicking on a row in the table displays the full event details in the 
box under the table. 
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€ Date: Date and time of the batch event.

€ User Name: User that initiated the event. User names only display if you•re using the Access Con-
trol feature to help satisfy the 21CFR Part 11 data security requirements. Go to •Enabling Access 
ControlŽ on page 391 to learn how to set it up.

€ Message: Description of the event that took place.

€ Comment: Comments entered by the user when the batch was saved. 

You can copy the information in the History pane to use in other documents:

1. Click the History pane to make sure it•s active.

2. Click Edit in the main menu and select Copy. 

3. Open a document and click Paste.

Making Changes to a Batch 
1. Select File in the main menu and click Open Batch.
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2. A list of the last five batches opened will display. 

€ Select one of these files or click Browse to open the Batch folder and select a different one.

€ To open a batch used in a run file, click Browse. Go to the Run folder in the Compass for iCE direc-
tory and select the run file that uses the batch you want to edit.

3. To make changes to the batch, see the steps in •Creating a New BatchŽ on page 42. Then select File from 
the main menu and click Save or Save As.

Viewing and Editing Batches in Completed Runs
1. Click the Analysis screen and open your run file(s).

2. After the run opens, click the Batch screen to view the batch used with the run.

If you opened more than one run file, you can switch between viewing batches for each file. Just click 
the down arrow in the Run box and select the batch you want to view from the drop down list.

3. In completed run files, you can only make edits to the sample and method names in a batch, and these 
changes are saved to the run file only. Update sample and method names as needed. 

4. Click the Analysis screen. Then select File from the main menu and click Save or Save As to save the 
new changes to the run file.
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Batch Reports
You can export a PDF file of sample and method details for each injection in the batch for completed run 
files.

1. Go to the Analysis or Run Summary screen, then click File > Open Run and select a run file (if you 
don•t have one open already).

2. After the run opens, go to the Batch screen.

3. Select File from the main menu and click Batch Report.

4. The report name defaults to the run file name. If you want to change it, type in the Report Name box to 
make updates.

5. The Batch Report PDF is exported to the Runs folder in the Compass for iCE directory. It•ll be in a folder 
with the report name used in the prior step. When the reports are done, the folder opens for you auto-
matically.
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Here•s an example Batch Report:



page 59

User Guide for Maurice, Maurice C. and Maurice S.

Chapter 6:  
CE-SDS Batches

Chapter Overview
€ Batch Screen Overview

€ Opening a Batch

€ Creating a New Batch

€ Viewing Replicate Injections

€ Batch History

€ Making Changes to a Batch

€ Viewing and Editing Batches in Completed Runs

€ Batch Reports
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Batch Screen Overview
You can use the Batch screen to create, view, and edit batches. To get to this screen, click the Batch screen 
tab:

Batch Screen Panes

The Batch screen has five panes:

€ Layout - Displays a map of either the 96-well plate or 48-vial tray of batch sample locations.

€ Injections - Lists the injections, sample ID, sample locations and methods that Maurice or Maurice S. 
will execute for each sample in the batch.

€ History - Lists all batch file events from initial creation to the most current update. 

€ Notes - Lets you enter specific information about your batch. 

€ Methods - Lets you create methods and enter method parameters used in the batch.
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Software Menus Active in the Batch Screen

These main menu items are active in the Batch screen:

€ File

€ Edit

€ Instrument (when the software is connected to Maurice or Maurice S.)

€ Window

€ Help

File Menu

These File menu options are active:

€ New Batch - Creates a new batch from a starter template.

€ Open Batch - Opens an existing batch.

€ Save/Save As - Saves the open batch.

€ Batch Report - Exports a table of sample and method details for each injection in the batch as a PDF 
file. This menu item is only active for batches in completed runs. 

€ Exit - Closes Compass for iCE.
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Edit Menu

The following Edit menu options are active in the Batch screen: 

€ Cut - Cuts the information currently selected. 

€ Copy - Copies the information currently selected.

€ Paste - Pastes the copied information. 

NOTE: Cut, Copy and Paste work differently depending on the pane you•re in. How and when you can use 
them is described throughout the chapter. 

€ Plate Layout - Lets you select between a 96-well plate or a 48-vial tray to run samples in.

€ Default Analysis - Displays the default settings that will be used to analyze the data generated with 
your batch. 

€ Preferences - Lets you set and save your preferences for data export, graph colors, grouped data and 
Twitter settings. See Chapter 13, •Setting Your Preferences• for more information.
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Opening a Batch 
To open an existing batch:

1. Select File in the main menu and click Open Batch. 

2. A list of the last five batches opened will display. Select one of those or click Browse to open the 
Batches folder and select a different one.

3. To make changes to the batch, see the steps in •Creating a New BatchŽ on page 64. When you•re done, 
select File from the main menu and click Save. 
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Creating a New Batch 
To create a new batch, we recommend that you use one of the template methods and make any necessary 
modifications from there. 

Step 1 - Open a Template Batch 

1. Select File in the main menu and click New Batch:

NOTE: If you•re using a Maurice system, both cIEF and CE-SDS template batches are available in the menu.

2. Select Maurice CE-SDS. A batch using the default method will display. 
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Step 2 - Assign Your Samples

The Layout pane shows the default locations of where batch reagent should be placed in your Maurice sys-
tem•s samples and reagents platform, and a map of either the 96-well plate or the 48-vial tray used for sam-
ples.

The same reagent locations are used for every batch:

€ P1 - Conditioning Solution 1 with orange pressure cap

€ P2 - Conditioning Solution 2 with orange pressure cap

€ P3 - DI water with orange pressure cap

€ P4 - Separation Matrix with orange pressure cap

€ P5 - Wash Solution vial with orange pressure cap

€ P6 - Empty vial (air) with orange pressure cap

€ N1 - Wash Solution vial with clear screw cap

€ N2 - Wash Solution vial with clear screw cap

€ N4 - Running Buffer - Bottom with clear screw cap

1. To assign samples, select a 96-well plate or 48 vials depending on what you•re running. Clicking on the 
vial/plate icon toggles between formats. 
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2. To select samples:

€ Add samples and select methods later: Use your mouse to highlight the well or vial positions 
your samples are located in, then click Add. For this example we•re using a 96-well plate. 

NOTE: The template batch automatically adds a sample in well or vial A1 by default, but if you don•t have 
a sample in this position you can remove it after you•ve added new positions for your samples. 

€ Add samples with preassigned methods: Highlight the well or vial positions your samples are 
located in, then right-click and select a method. 

Either option of adding samples populates the Injections table:
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To remove samples, just highlight the ones you want to remove and click Remove. They•ll also be 
removed in the Injections table. You can also right-click well(s) or vial(s) in the Layout pane and click 
Remove Sample(s). 

3. Compass for iCE can monitor the current during a separation for you, stop it if the current drops below 
the minimum value and reinject the sample for you automatically. Reinjections are enabled by default, 
but if you don•t want to use this feature just click the reinject icon to toggle it off. 

NOTES:  
If a sample was reinjected, the injection row will be flagged in the Injections pane in the Run Summary 
screen. See •Injection FlagsŽ on page 158 for more info. 
 
A maximum of 10 reinjections are allowed per batch.
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4. The sample platform is temperature controlled with a default setting of 10 °C. To change the tempera-
ture or turn it off, click the down arrow next to the temperature and select an option. 

NOTE: The two reagent rows are kept at room temperature. 

Step 3 - Assign Your Method Parameters

NOTE: There are three default methods. We recommend using the default method parameters for the 
listed sample types. Please see the Maurice CE-SDS Application Guide for more information on method 
optimization.

The Methods pane lists all of the methods used in a batch. You can add and remove methods here and 
change method parameters. 

1. In the Methods table, click the first cell in the Name column and enter a new method name if needed. 
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2. Click the first cell in the Sample Load column, then click the selection button [...] to set your sample load 
profile time (in seconds) and voltage.

€ To change time and voltage parameters: Just click in a cell under Time or Voltage and type 
the new value(s).

€ To add a profile step: Click Add. A new row will be added in the table. Then just type in a load 
time (in seconds) and voltage value.

€ To remove a profile step: Select the row you want to remove and click Remove.  

3. Click the first cell in the Separation column the selection button [...] to set your separation profile 
parameters (in minutes) and voltage.

NOTE: Run your reduced IgG samples and IgG Standard for 25 minutes and the CE-SDS MW Markers for 30 
minutes. Run your non-reduced IgG samples and IgG Standard for 35 minutes. The default separation 
voltage for all sample types is 5750 volts.
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€ To change time and voltage parameters: Just click in a cell under Time or Voltage and type 
the new value(s).

€ To add a profile step: Click Add. A new row will be added in the table. Then just type in a load 
time (in seconds) and voltage value.

€ To remove a profile step: Select the row you want to remove and click Remove.  

4. You can now: 

€ Click New in the upper right corner of the Methods pane to add a new one if you want to use dif-
ferent methods for different samples. Then just repeat the steps above for the new method.

€ Make updates to the remaining methods by repeating the prior steps.

€ Select a method and click Remove in the upper right corner of the Methods pane to delete it.

Step 4 - Set Up Your Injections

The Injection pane lists all sample injections for the batch. Any samples that were added in •Step 2 - Assign 
Your SamplesŽ are automatically added to this list.

Selecting an injection in the table also selects the sample the injection will be made from in the plate or vial 
map in the Layout pane and vice-versa. 
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1. To add sample names, click the Sample ID cell for the injection and type a name. 

The sample name also displays when you hover the mouse over the sample in the plate or vial map:

2. Assign your methods to each injection. Just click the Method cell for the injection and select a method 
from the drop down menu. If you added your samples with pre-assigned methods and don•t need to 
make any changes, skip to the next step. 
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Hovering over a method name displays the method parameters:

3. You can add or remove injections as needed using a few different options. If you don•t need to make any 
changes here, just skip to the next step.

€ To add sequential replicate injections: Highlight an injection and click Replicate. A new injec-
tion will be added under the row you selected

€ To add injections at the end of the batch: Click on any sample position in the Layout pane or 
sample injection in the Injection table and click Add. A new injection using the same sample will 
be added to the end of the table. Assign the method if needed. 
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€ To copy and paste injections: Right-click on an injection in the Injection table and select Copy. 
Click on the injection number above where you want to insert the copied injection, right click 
and select Paste. The copied injection will be inserted under the row you selected. 

Step 5 - Add Batch Notes (Optional)

1. Click on the Notes pane.

2. Click in the notes area and type any information you want to add about your batch.

Step 6 - Modify Default Analysis Parameters (Optional) 

You can preset the parameters used to analyze data generated with the batch. We recommend using the 
default parameters for CE-SDS applications, but if you need to modify parameters:
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1. Select Edit from the main menu and click Default Analysis. The following screen will display:

2. Change the parameters you want to, then click OK. For detailed information on analysis parameters, 
please refer to •Analysis Settings OverviewŽ on page 244.

Step 7 - Save Your Batch

1. Once all of your sample, method and injection info is entered, select File > Save. Enter any comments 
on the batch if you want, then click Save.
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2. Enter a name for your batch then click Save. 

Viewing Replicate Injections
Injections with replicates have an arrow next to the injection number. You can expand or collapse the list of 
replicate injections by toggling the arrow:

€ To show all replicate injections in the batch, click the Expand All Injections button.
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€ To hide all replicate injections in the batch, click the Collapse All Injections button.

Batch History
Clicking on the History pane shows the batch event history, starting with the date and time the batch was 
created through the most current event. Clicking on a row in the table displays the full event details in the 
box under the table. 
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€ Date: Date and time of the batch event.

€ User Name: User that initiated the event. User names only display if you•re using the Access Con-
trol feature to help satisfy the 21CFR Part 11 data security requirements. Go to •Enabling Access 
ControlŽ on page 391 to learn how to set it up.

€ Message: Description of the event that took place.

€ Comment: Comments entered by the user when the batch was saved. 

You can copy the information in the History pane to use in other documents:

1. Click the History pane to make sure it•s active.

2. Click Edit in the main menu and select Copy. 

3. Open a document and click Paste.

Making Changes to a Batch 
1. Select File in the main menu and click Open Batch.
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2. A list of the last five batches opened will display. 

€ Select one of these files or click Browse to open the Batch folder and select a different one.

€ To open a batch used in a run file, click Browse. Go to the Run folder in the Compass for iCE direc-
tory and select the run file that uses the batch you want to edit.

3. To make changes to the batch, see the steps in •Creating a New BatchŽ on page 64. Then select File from 
the main menu and click Save or Save As.

Viewing and Editing Batches in Completed Runs
1. Click the Analysis screen and open your run file(s).

2. After the run opens, click the Batch screen to view the batch used with the run.

If you opened more than one run file, you can switch between viewing batches for each file. Just click 
the down arrow in the Run box and select the batch you want to view from the drop down list.

3. In completed run files, you can only make edits to the sample and method names in a batch, and these 
changes are saved to the run file only. Update sample and method names as needed. 

4. Click the Analysis screen. Then select File from the main menu and click Save or Save As to save the 
new changes to the run file.
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Batch Reports
You can export a PDF file of sample and method details for each injection in the batch for completed run 
files.

1. Go to the Analysis or Run Summary screen, then click File > Open Run and select a run file (if you 
don•t have one open already).

2. After the run opens, go to the Batch screen.

3. Select File from the main menu and click Batch Report.

4. The report name defaults to the run file name. If you want to change it, type in the Report Name box to 
make updates.

5. The Batch Report PDF is exported to the Runs folder in the Compass for iCE directory. It•ll be in a folder 
with the report name used in the prior step. When the reports are done, the folder opens for you auto-
matically.
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Here•s an example Batch Report:
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Chapter 7:  
Running cIEF Applications on  
Maurice and Maurice C. 

Chapter Overview
€ Before You Throw the Switch

€ Power Up

€ Running cIEF Applications

€ Post-batch Procedures

€ Checking Your Data
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Before You Throw the Switch
Ensure that everyone using Maurice have:

€ Received instruction in general safety practices for laboratories.

€ Received instruction in specific safety practices for Maurice.

€ Received instruction on handling of biohazards (if biohazardous materials are to be used on Maurice).

€ Read and understood all Product Inserts and related Safety Data Sheets (SDS).

Power Up
1. Turn on the computer connected to Maurice.

2. Turn on Maurice•s main power switch.

3. Wait for Maurice to initialize. His indicator light will turn from magenta to blue when he•s done.

4. Double-click the Compass for iCE software icon on the computer desktop to open the application. 

5. Connect Maurice to Compass for iCE.

Running cIEF Applications

What You•ll Need

€ Maurice cIEF Cartridges

€ Maurice cIEF Method Development Kit (optional)

€ Maurice System Suitability Kit (optional)

€ Maurice cIEF Fluorescence Calibration Standard

€ Maurice cIEF pI Markers (3.38, 4.05, 5.85, 6.14, 7.05, 8.4, 9.99, or 10.17)

€ 0.5% Methyl Cellulose Solution

€ 1% Methyl Cellulose Solution

€ iCE Electrolyte Kit

€ Deionized (DI) water

€ Glass reagent vials, 2 mL 

€ 96-well plate or vials with integrated inserts for samples

€ Clear screw caps for vials
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€ Blue pressure caps for vials

€ P10, P20, P200, P1000 pipettes and tips

€ Electrolyte pipette

€ Vortexer

€ Table-top centrifuge with plate adapter or vial adapter (12 mm, 2 mL vials)

Step 1: Prep Your Markers, Samples and Reagents

NOTES:  
You can prepare your samples to run either in 96-well plates or vials.  
 
If you need to seal the 96-well plate during your run, we recommend the 4titude Pierceable Film (PN 4ti-
0566, 4titude). It can be used in both absorbance and native fluorescence modes. If you•re currently using 
X-Pierce adhesive film (PN XP-100, Excel Scientific), we recommend using it for absorbance mode only.

System Suitability Peptide Panel (Optional)

NOTES:  
Run the System Suitability Peptide Panel when you need to confirm performance on Maurice.  
 
The System Suitability Peptide Panel is lyophilized. Always reseal the foil bag containing the unopened 
tubes with desiccant to prevent moisture absorption.

1. Using scissors, carefully cut the top the package off leaving the sealing strip intact. 

2. Take out the strip of tubes and cut one clear tube of lyophilized System Suitability Peptide Panel from 
the strip. Return the remaining tubes to the original package, reseal tightly and store at 2-8°C. 

3. Pierce the foil on the tube with a clean pipette tip.

4. Add 40 µL of DI water to the tube. Gently resuspend by pipetting up and down to mix.

5. Add 160 µL of the System Suitability Test Mix to the freshly reconstituted Peptide Panel. Gently mix by 
pipetting up and down. Transfer this solution to a 1.5 mL microcentrifuge tube.

6. Vortex the tube 3 times, 5 seconds each.

7. Centrifuge the tube at 10,000 xg for 3 minutes to sediment any particulates.
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8. Carefully aspirate the top 160 µL of the solution and pipette it into a sample vial with integrated insert or 
well of a 96-well plate. You•ll want to insert the pipette tip all the way to the bottom of the insert or well 
when you dispense the solution to avoid introducing bubbles.

NOTE: Make sure to check for and remove any bubbles at the bottom of the sample vial or well.

9. If you're using vials, close the sample vial with a clear screw cap.

Samples

1. In a microcentrifuge tube, prepare your sample at a concentration of 1 mg/mL in a final volume of 40 µL 
in DI water. 

2. In a separate tube, prepare IEF Separation Mix containing your chosen pI marker(s).

NOTE: Check out the Method Development Guide for suggested IEF Separation Mix recipes.

3. Add 160 µL of IEF Separation Mix to the 40 µL of your sample.

4. Vortex the tube 3 times, 5 seconds each.

5. Centrifuge the tube at 10,000 xg for 3 minutes to sediment any particulates

6. Carefully aspirate the top 160 µL of the sample and pipette it into your sample vial with integrated insert 
or well of a 96-well plate by inserting the pipette tip all the way to the bottom to avoid introducing bub-
bles. 

Note: Make sure to check for and remove any bubbles at the bottom of the sample vial or well.

Clear screw cap

Sample vial with
integrated insert
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7. If you're using vials, close the sample vial with a clear screw cap.

pI Markers

1. Open the vial of lyophilized pI marker by lifting the center tab and gently pulling it back to break the 
metal seal. Slowly remove the rubber stopper.

2. Add 210 µL of DI water to the vial. 

3. Put the rubber stopper back in the vial and vortex 3 times, 5 seconds each time to completely reconsti-
tute the lyophilized cake. Repeat this step for all pI markers you're using.

4. Aliquot 20 µL of each reconstituted pI marker into separate tubes for storage.

NOTES:  
Keep your reconstituted pI markers on ice until you're ready to add them to your sample or IEF Separation 
Mix. 
 
If you'll use the pI markers within a month, store the aliquots at 2-8 °C. Otherwise, store the aliquots at  
-20 °C. They'll be stable up to 6 months. 

5. Use 2 µL of each pI marker for every 200 µL of sample. 

Reagents

NOTE: Don't reuse reagents, vials or the clear screw caps. Always keep the blue pressure caps paired with 
their respective reagents. If you want to reuse pressure caps, first wash them thoroughly with DI water, 
soak overnight in DI water, rinse caps thoroughly with DI water again and air dry them before reusing. 

1. Pipette 2 mL of 0.5% Methyl Cellulose into a glass reagent vial, label and close with a blue pressure cap.
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2. Pipette 500 µL of Fluorescence Calibration Standard in a glass reagent vial, label and close with a blue 
pressure cap.

3. Pipette 2 mL of DI water into a glass reagent vial, label and close with a blue pressure cap.

4. Close an empty glass reagent vial with a blue pressure cap. 

5. Pipette 2 mL of DI water into a glass reagent vial, label and close with a clear screw cap.

Step 2: Prep the Cartridge 

1. Take the cIEF Cartridge out of its packaging. Save the packaging, you•ll need it later to store the car-
tridge.

NOTE: When you remove the cartridge from its packaging, make sure the cartridge inlet doesn•t come in 
contact with any surface.

Pressure cap

Glass reagent vial

Clear screw

Glass reagent vial

cap
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2. Put the cartridge on a flat surface with its electrolyte tanks facing up. 

3. Remove the stoppers from both electrolyte tanks.

4. Add 2 mL of Catholyte solution to the OH- electrolyte tank (white port). 

5. Add 2 mL Anolyte solution to the H+ electrolyte tank (red port). 

NOTE: Make sure you don•t overfill the electrolyte tanks. 

Anolyte
Tank

Optical
Window

Cartridge
Inlet

Catholyte
Tank
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6. Seal each tank with the rubber stoppers. Use the grey stopper for the OH- tank and the red one for the 
H+ tank. If excess liquid comes out of the tank, make sure to wipe it with a laboratory wipe.

Step 3: Install the Cartridge

1. Open Maurice•s door by touching the metal plate on top of the door. 

NOTE: The indicator light on Maurice•s front panel will blink rapidly as the door disengages.

2. Swing the door open to access the cartridge slot and the reagents and samples platform. The lights on 
either side of the slot will be orange. 
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3. Double check to make sure you•ve got electrolytes loaded and the tanks are properly sealed with the 
stoppers. 

4. Lift the cartridge and hold it vertically using the finger holds on either side, cartridge inlet down, with 
the cIEF label facing you.

5. Gently insert it into the slot. You•ll feel the alignment groove on the cartridge align inside the slot when 
you insert it.
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6. Continue to slide the cartridge into the slot until the locking mechanism engages. The lights on either 
side of the slot will change to blue once the cartridge is installed correctly.

Step 4: Load Samples and Reagents

1. Place the reagent vials into their respective positions on the sample and reagents platform:

NOTES:  
The two reagent rows in Maurice•s reagent and sample platform are kept at room temperature. 
 
Pressure caps are blue and have a raised, ringed surface. They should only be used in Reagent Row P. Use 
reagent vials with clear screw caps in Row N. 

€ P1 - 0.5% Methyl Cellulose with blue pressure cap

€ P2 - Fluorescence Calibration Standard with blue pressure cap

€ P3 - Water vial with blue pressure cap

€ P6 - Empty vial (air) with blue pressure cap

€ N1 - Water vial with clear screw cap
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2. Depending on what you prepared your samples in, put your 96-well sample plate in the metal plate 
insert or your sample vials in the metal vial insert. 

NOTES:  
If you need to seal the 96-well plate during your run, we recommend the 4titude Pierceable Film (PN 4ti-
0566, 4titude). It can be used in both absorbance and native fluorescence modes. If you•re currently using 
X-Pierce adhesive film (PN XP-100, Excel Scientific), we recommend using it in absorbance mode only. 
 
Well A1 on the 96-well plate should be in the top left corner of the insert.

3. Close the instrument door. Maurice locks it automatically. 

Step 5: Create a Batch

1. Launch Compass for iCE.

2. Select the Batch tab. This is where you•ll enter sample/injection information, methods and batch 
parameters. 
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3. To create a batch, make sure Maurice is connected to Compass for iCE. If he isn•t, select Instrument and 
click Connect. Then select your Maurice system and click Connect.

To create a new batch: 

€ On Maurice systems - in the main menu, select File > New Batch > Maurice cIEF.

€ On Maurice C. systems - in the main menu, select File > New Batch

To use an existing batch: In the main menu, select File > Open Batch.

NOTE: If you•re making changes to an existing batch, follow the steps in this section. Otherwise skip to 
•Step 6: Start the BatchŽ on page 100.
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4. In the Layout pane, clicking on the vial/plate icon toggles between formats. Select 48 vials or a 96-well 
plate depending on what you•re running. 

5. Use your mouse to highlight the well positions for each of your samples, then click Add.

This populates the Injections table:
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6. The sample platform is temperature controlled with a default setting of 10 °C. To change the tempera-
ture or turn it off, click the down arrow next to the temperature and select an option. 

NOTE: The two reagent rows are kept at room temperature. 

7. In the Methods pane:

NOTE: We recommend using the default method parameters. Please see the Maurice cIEF Method Devel-
opment Guide for more information on method optimization.

a. Click the first cell in the Name column and enter a method name. 
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b. Click the first cell in the Separation column, then click the selection button [...] to set the pre-focus-
ing and focusing time (in minutes) and voltage. 

c. Click the first cell in the Detection column then click the selection button [...] to set your exposure 
times for absorption and fluorescence detection modes.

d. Click the first cell in the Sample Load(s) column and set the load time in seconds.
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e. Click the first cell in the pI Markers column to select pI markers. Add new markers or remove existing 
ones then click OK.

f. Optional: Click the first cell in the Ampholytes column and enter the ampholytes you•re using. 

g. Optional: Click the first cell in the Additives column and enter any additives you•re using. 
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8. You can now: 

€ Make updates to the remaining methods by repeating the prior steps.

€ Select a method and click Remove in the upper right corner of the Methods pane to delete it.

€ Click New in the upper right corner of the Methods pane to add a new one if you want to use dif-
ferent methods for different samples. Then just repeat the steps above for the new method.

9. In the Injections pane:

€ To add sample names: click the Sample ID cell for the injection and type a name.

€ To assign methods for each injection: Click the Method cell for the injection and select a 
method from the drop down menu.

€ To add sequential replicate injections: Highlight an injection and click Replicate. A new injec-
tion will be added under the row you selected
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€ To add injections at the end of the batch: Click on any sample position in the Layout pane or 
sample injection in the Injection table and click Add. A new injection using the same sample will 
be added to the end of the table. Assign the method if needed. 

€ To copy and paste injections: Right-click on an injection in the Injection table and select Copy. 
Click on the injection number above where you want to insert the copied injection, right click 
and select Paste. The copied injection will be inserted under the row you selected. 

10. Click on the Notes pane, then click in the notes area and type any information you want to add about 
your batch (optional).

11. You can preset the parameters used to analyze data generated with the batch (optional). We recom-
mend using the default parameters for cIEF applications, but if you want to modify parameters:

a. Select Edit from the main menu and click Default Analysis. The following screen will display: 
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b. Change the parameters you want to, then click OK. For detailed information on analysis parameters, 
please refer to •Analysis Settings OverviewŽ on page 244

12. Once all of your sample, method and injection info is entered, select File > Save. Enter any comments 
on the batch if you want, then click Save.

13. Enter a name for your batch then click Save. 
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Step 6: Start the Batch

1. Make sure Maurice is connected to Compass for iCE. If he isn•t, select Instrument and click Connect. 
Then select your Maurice system and click Connect.

2. Click Start to start your batch. 

3. The Start Run box shows you the number of injections and batches remaining on your cartridge. Make 
sure you still have enough injections left before you start the run. If not, prep a new cartridge. 

4. Click in the Results File name box if you want to change the default run file name. Otherwise just leave 
it as is.

5. If you don•t want to save the file to the default Runs folder, click Browse to select a different location.

6. Enter any run details you•d like in the Comments box (optional).

7. Click Start to start the run.

NOTE: The indicator light on Maurice•s front panel will pulse slowly while he•s running the batch.
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To monitor the progress of your batch, click the Run Summary tab. See Chapter 9, •Run Status• for more 
details.

To view results, analyze results or change analysis parameters on completed injections while the batch is 
still running, click the Analysis tab. See Chapter 12, •cIEF Data Analysis• for more details.
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When your batch is complete, you can view electropherograms for all injections in the Analysis tab, and 
all batch and injection details in the Run Summary tab.

NOTE: If you•d like Maurice to let you know when your run is done, you can set him up to tweet you. Go to 
•Setting Up Maurice Systems to Send TweetsŽ on page 383 for more info.

Post-batch Procedures
When the batch is done:

1. Open Maurice•s door. The lights on either side of the cartridge slot will be orange as Maurice will have 
already disengaged the cartridge. 

2. Remove your reagent vials and samples and discard. 

3. Gently pull out the cartridge making sure the cartridge inlet doesn•t come into contact with any surface.
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If you're at 100 injections, the cartridge is at its limit. Put it back in its original packing and discard it 
per your institution's safety and waste disposal guidelines.

NOTE: Disposal of cartridges, sample plates and vials depends on the samples you ran. If you aren•t sure 
what your sample origins are, we recommend you dispose of everything in biohazard waste. 

If you've still got injections left and the cartridge will be used again within 24 hours. You don't 
need to do anything. Just leave the cartridge in Maurice.

If you've still got injections left and the cartridge won•t be used within 24 hours. Clean and store 
the cartridge. Maurice has already cleaned the capillary for you, so here's all you need to do:

a. Put the cartridge on a flat surface with its electrolyte tanks facing up.

b. Remove the stoppers from both the electrolyte tanks.

c. Using an electrolyte pipette or low vacuum, aspirate the solutions from each tank.

d. Fill each tank with 2 mL DI water, then aspirate it out. Repeat this rinse 3 times. 

NOTE: Make sure not to get any liquid on the cartridge•s optical window.
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e. Aspirate all the remaining liquid and make sure that the tanks are dry. 

f. Put the stoppers back on the tanks.

g. Put the cartridge back in its protective packaging and store it at room temperature.

!WARNING! SHARPS HAZARD 
The capillary inlet of the cartridge may present a potential sharps hazard. Dispose of used cartridges 
according to your organizations health and safety regulations. 

!WARNING! BIOHAZARD  
Cartridges, sample plates and vials should be handled by procedures recommended in 
the CDC/NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). 
The manual is available from the U.S. Government Printing Office or online at http://
www.cdc.gov/biosafety/publications/bmbl5/.  
 
Depending on the samples used, the cartridges, plates and vials may constitute a chemi-
cal or a biohazard. Dispose of the cartridges, plates and vials in accordance with good lab-
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oratory practices and local, state/provincial, or national environmental and health regulations. Read 
and understand the Safety Data Sheets (SDSs) provided by the manufacturers of the chemicals in 
the waste content before you store, handle, or dispose of chemical waste.

Checking Your Data
Compass for iCE detects your sample protein and pI marker peaks and reports results automatically. But, we 
always recommend you review your data using the steps in this section as a good general practice to make 
sure your results are accurate. If you see a data warning in the Experiment pane, these steps will also help 
you identify and correct any issues. 

Step 1: Select Your Detection Mode

1. Go to the Analysis screen and open your run (if it isn•t already open).

2. The data displays in absorbance mode by default. If you want to look at fluorescence data instead, select 
Edit from the main menu and click Analysis. In the Analysis window, select Detection in the left side-
bar, then click Fluorescence in the Detection page. 

Step 2: Check Your pI Markers

To make sure your pI markers are identified correctly:

1. Go to the Analysis screen.

2. Click Markers in the View bar. 
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3. Click the Single View icon in the View bar.

4. Click Injection 1 in the Experiment pane.

5. Check that your pI markers in the electropherogram have been correctly identified. Each marker peak 
will have a green vertical line running through it and be labeled Mkr. They•re also identified with an M in 
the Peaks table. 

6. If your pI markers aren•t identified correctly, here•s how to manually correct them: 

To set an unidentified peak as a pI marker: Right-click the peak in the electropherogram or Peaks 
table and select Force Standard. Compass will assign that peak as a pI marker, and correctly reassign 
the remaining pI marker peaks. 
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A lock icon indicating the pI marker was set manually will display next to the peak in the Peaks table and 
a check mark will appear next to the injection in the Experiment pane to show a manual correction was 
made.



Checking Your Data page 108

User Guide for Maurice, Maurice C. and Maurice S.

NOTE: To remove pI marker peak assignments that were made manually, right click on the peak in the 
electropherogram or Peaks table and click Clear. To clear all the manual settings for the injection, click 
Clear All.

If an incorrect peak is identified as a pI marker: Right-click the peak in the electropherogram or 
Peaks table and select Not a Marker. Compass should correctly reassign the remaining peaks as pI 
markers and update the Peaks table.

An M with a red slash through it will appear next to the incorrectly assigned peak in the Peaks table and 
a check mark will appear next to the injection in the Experiment pane to show a manual correction was 
made. 

7. Repeat the previous steps for the remaining pI marker peaks as needed in the current injection and for 
all other injections to make sure all your pI markers are identified correctly.

Step 3: Checking Sample Peaks

All detected peaks will be labeled automatically with the calculated protein pI.
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NOTE: The reported protein pI in Compass may vary slightly from predicted pIs based on sample, buffer, 
and method conditions. 

To make sure your sample proteins are identified correctly:

1. Click Samples in the View bar. 

2. Click the Single View icon in the View bar.

3. Click Injection 1 in the Experiment pane. 

4. If your sample peaks aren•t identified correctly, here•s how to manually correct them: 

If a peak is incorrectly identified as a sample peak: Right-click the peak in the electropherogram or 
Peaks table and select Remove Peak. Compass will no longer identify it as a sample peak in the electro-
pherogram and the peak data will be removed in the results table. 
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A check mark will appear next to the injection in the Experiment pane to indicate a manual correction 
was made.

To identify a peak as a sample peak: Right-click the peak in the electropherogram or Peaks table and 
select Add Peak. Compass will calculate and display the results for the peak in the results table and 
identify the peak in the electropherogram. 
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A check mark will appear next to the injection in the Experiment pane to indicate a manual correction 
was made.

NOTE: To remove sample peak assignments that were made manually and go back to the original peak 
data, right-click the peak in the electropherogram and select Clear.

5. Repeat the previous steps for the remaining injections to make sure all sample peaks are correctly iden-
tified.

Step 4: Assigning Peak Names

Compass can also optionally identify and automatically name sample peaks using user-specified peak name 
settings. For more information on how to do this, see •Peak Names SettingsŽ on page 354.
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Chapter 8:  
Running CE-SDS Applications on  
Maurice and Maurice S. 

Chapter Overview
€ Before You Throw the Switch

€ Power Up

€ Running CE-SDS Applications

€ Post-batch Procedures

€ Checking Your Data
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Before You Throw the Switch
Ensure that everyone using Maurice have:

€ Received instruction in general safety practices for laboratories.

€ Received instruction in specific safety practices for Maurice.

€ Received instruction on handling of biohazards (if biohazardous materials are to be used on Maurice).

€ Read and understood all Product Inserts and related Safety Data Sheets (SDS).

Power Up
1. Turn on the computer connected to Maurice.

2. Turn on Maurice•s main power switch.

3. Wait for Maurice to initialize. His indicator light will turn from magenta to blue when he•s done.

4. Double-click the Compass for iCE software icon on the computer desktop to open the application. 

5. Connect Maurice to Compass for iCE.

Running CE-SDS Applications

What You•ll Need

€ Maurice CE-SDS Size Application Kit which includes:

€ Maurice CE-SDS Cartridges

€ Cartridge Cleaning Vials

€ Separation Matrix

€ Running Buffer (Top and Bottom)

€ 1X Sample Buffer

€ Wash Solution

€ Conditioning Solutions (1 and 2)

€ 25X Internal Standard

€ Glass reagent vials, 2 mL 

€ 96-well plates

€ Clear screw caps for vials

€ Orange pressure caps for vials

€ Maurice CE-SDS IgG Standard (optional)
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€ Maurice CE-SDS MW Markers (optional)

€ � -mercaptoethanol (� ME, >98% = 14.2 M) for reducing conditions

€ Iodoacetamide (IAM, 250 mM) for alkylation at non-reducing conditions

€ Deionized (DI) water

€ Sample vials with integrated inserts for samples (optional)

€ P10, P20, P200, P1000 and pipette tips

€ Water bath or thermocycler

€ Vortexer

€ Table-top centrifuge with plate adapter or vial adapter (12 mm, 2 mL vials)

Step 1: Prep Your Internal Standard, Samples and Reagents

NOTE: You can prepare your samples to run either in 96-well plates or vials. Using 96-well plates is the 
default method. 

Internal Standard

NOTES:  
The Internal Standard is lyophilized. Always reseal the foil bag containing the unopened tubes with desic-
cant to prevent moisture absorption. 
 
Aliquot the reconstituted solution into appropriately sized vials and store at -80 °C for long term storage. 
For short-term storage (< 1 week), the solution can be stored at 2-8 °C

1. Open the vial of lyophilized 25X Internal Standard by lifting the center tab and gently pulling it back to 
break the metal seal. Then slowly remove the rubber stopper.

2. Reconstitute by adding 240 µL of 1X Sample Buffer. Pipette up and down a few times to mix thoroughly. 
This results in a 25X Internal Standard solution.

NOTE: Don•t vortex the reconstituted Internal Standard during prep.
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Sample Prep Under Reducing Conditions

Reduced IgG Sample

1. In a microcentrifuge tube, dilute your IgG sample with 1X Sample Buffer to a concentration of 1mg/mL 
in a final volume of 50 µL. 

NOTE: Dilute at least 1:1 with 1X Sample Buffer.

2. Add 2 µL of reconstituted 25X Internal Standard for every 50 µL of sample volume.

3. Add 2.5 µL of 14.2 M � -mercaptoethanol to 50 µL of sample.

4. Mix thoroughly.

NOTE: Heating in the presence of SDS linearizes the protein and allows for SDS binding. The reducing 
agents break up inter- and intra-molecular disulfide bonds.

5. Centrifuge the tube and heat the mixture in a water bath or thermocycler at 70 °C for 10 minutes.

6. Put the tube on ice for 5 minutes.

7. Vortex briefly and spin down.

Reduced IgG Standard (Optional)

NOTE: The IgG Standard is lyophilized. Always reseal the foil bag containing the unopened tubes with des-
iccant to prevent moisture absorption.

1. Using scissors, carefully cut the top of the foil package, leaving the sealing strip intact. 

2. Take out the strip of tubes and carefully cut one pink tube of lyophilized IgG Standard from the strip. Put 
the unopened tubes back in the package, seal tightly and store at 2-8 °C.

3. Pierce the foil on the tube with a clean pipette tip.

4. Reconstitute the IgG Standard with 50 µL of 1X Sample Buffer. Gently resuspend by pipetting the solu-
tion up and down. Transfer the solution to a microcentrifuge tube.

5. Add 2 µL of reconstituted 25X Internal Standard.

6. Add 2.5 µL of 14.2 M � -mercaptoethanol.

7. Mix thoroughly by vortex.
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8. Centrifuge the tube and heat mixture in a water bath or thermocycler at 70 °C for 10 minutes.

9. Put the tube on ice for 5 minutes.

10. Vortex briefly and spin down.

CE-SDS Molecular Weight (MW) Markers (Optional)

NOTE: The CE-SDS MW Markers are lyophilized. Always reseal the foil bag containing the unopened tubes 
with desiccant to prevent moisture absorption. 

1. Using scissors, carefully cut the top of the foil package leaving the sealing strip intact. 

2. Take out the strip of tubes and carefully cut one green tube of lyophilized CE-SDS MW Markers from the 
strip. Put the unopened tubes back in the package, seal tightly and store at 2-8 °C.

3. Pierce the foil on the tube with a clean pipette tip.

4. Reconstitute the CE-SDS MW Markers with 50 µL of 1X Sample Buffer. Gently resuspend by pipetting the 
solution up and down. Transfer the solution to a microcentrifuge tube.

5. Add 2 µL of reconstituted 25X Internal Standard.

6. Add 2.5 µL of 14.2 M � -mercaptoethanol.

7. Mix thoroughly.

8. Centrifuge the tube and heat the mixture in a water bath or thermocycler at 70 °C for 10 minutes.

9. Put the tube on ice for 5 minutes.

10. Vortex briefly and spin down.

Spin Samples, Standards and CE-SDS MW Markers
If you•re using a 96-well plate: 

1. Transfer 50 µL of each of your samples, IgG Standard and CE-SDS MW Markers to their designated wells 
in a 96-well plate. 

2. Cover the plate with a lid and spin for 10 minutes at 1000 xg in a centrifuge with a plate adapter. 

3. Pop any bubbles in the samples with a clean pipette tip.

If you•re using vials:

1. Transfer 50 µL of each of your samples, IgG Standard and CE-SDS MW Markers to their designated sam-
ple vials with integrated inserts.

2. Close the vials with a clear screw cap.

3. Place the vials in a centrifuge using a vial adapter (12 mm, 2 mL vials) and spin for 10 minutes at 1000 xg. 
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Sample Prep Under Non-reducing Conditions

Alkylation Reagent

NOTES:  
We use a 250 mM solution of iodoacetamide (IAM) as an alkylating reagent. 
 
Prepare a fresh 250 mM solution of iodoacetamide in DI water before use.

1. Weigh out 46 mg of IAM directly into a 1.5 mL microcentrifuge tube.

2. Add 1 mL of DI water to the tube and mix thoroughly.

Non-reduced IgG Sample

1. In a microcentrifuge tube, dilute your IgG sample with 1X Sample Buffer to a concentration of 1 mg/mL 
in a final volume of 50 µL.

NOTE: Dilute at least 1:1 with 1X Sample Buffer.

2. Add 2 µL of reconstituted 25X Internal Standard for every 50 µL of sample volume.

3. Add 2.5 µL of 250 mM IAM.

4. Mix thoroughly.

5. Centrifuge the tube and heat the mixture in a water bath or thermocycler at 70 °C for 10 minutes.

6. Put the tube on ice for 5 minutes.

Clear screw cap

Sample vial with
integrated insert
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7. Vortex briefly and spin down.

Non-reduced IgG Standard (Optional)

NOTE: The IgG Standard is lyophilized. Always reseal the foil bag containing the unopened tubes with des-
iccant to prevent moisture absorption.

1. Using scissors, carefully cut the top of the foil package, leaving the sealing strip intact. 

2. Take out the strip of tubes and carefully cut one pink tube of lyophilized IgG Standard from the strip. Put 
the unopened tubes back in the package, seal tightly and store at 2-8 °C.

3. Pierce the foil on the tube with a clean pipette tip.

4. Reconstitute the IgG Standard with 50 µL of 1X Sample Buffer. Gently resuspend by pipetting the solu-
tion up and down. Transfer the solution to a microcentrifuge tube.

5. Add 2 µL of reconstituted 25X Internal Standard.

6. Add 2.5 µL of 250 mM IAM.

7. Mix thoroughly by vortex.

NOTE: Heating in the presence of SDS linearizes the protein and allows for SDS binding. The alkylating 
agents prevent disulfide-bond scrambling catalyzed by free sulfhydryl groups. This minimizes the appear-
ance of fragments under non-reducing conditions.

8. Centrifuge the tube and heat mixture in a water bath or thermocycler at 70 °C for 10 minutes.

9. Put the tube on ice for 5 minutes.

10. Vortex briefly and spin down.

Spin Samples and Standards
If you•re using a 96-well plate: 

1. Transfer 50 µL of each of your samples and IgG Standard to their designated wells in a 96-well plate. 

2. Cover the plate with a lid and spin for 10 minutes at 1000 xg in a centrifuge with a plate adapter. 

3. Pop any bubbles in the samples with a clean pipette tip.

If you•re using vials:

1. Transfer 50 µL of your samples and IgG Standard to their designated sample vials with integrated inserts.

2. Close the vials with a clear screw cap.
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3. Place the vials in a centrifuge using vial adapter (12 mm, 2 mL vials) and spin for 10 minutes at 1000 xg. 

Reagents

NOTE: Don't reuse reagents, vials or the clear screw caps. Always keep the orange pressure caps paired 
with their respective reagents. If you want to reuse pressure caps, first wash them thoroughly with DI 
water, soak overnight in DI water, rinse caps thoroughly with DI water again and air dry them before reus-
ing. 

1. Pipette 1.5 mL of Conditioning Solution 1 into a glass reagent vial, label and close with an orange pres-
sure cap. 

2. Pipette 1.5 mL of Conditioning Solution 2 into a glass reagent vial, label and close with an orange pres-
sure cap.

3. Pipette 1.0 mL of Wash Solution into a glass reagent vial, label each and close with an orange pressure 
cap. 

4. Pipette 1.5 mL of Wash Solution into two glass reagent vials. Label each and close both with clear screw 
caps. 

Pressure cap

Glass reagent vial
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5. Pipette 1 mL of Separation Matrix into a glass reagent vial, label and close with an orange pressure cap. 

6. Pipette 1 mL of Running Buffer - Bottom into a glass reagent vial, label and close with a clear screw cap.

7. Pipette 1.5 mL of DI water into a glass reagent vials, label and close with an orange pressure cap.

8. Close an empty glass reagent vial with an orange pressure cap.

Step 2: Prep the Cartridge

1. Take the CE-SDS Cartridge out of its packaging. Save the packaging, you•ll need it later to store the car-
tridge.

NOTE: When you remove the cartridge from its packaging, make sure the cartridge inlet doesn•t come in 
contact with any surface.

 

Glass reagent vial

Clear screw
cap
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2. Pull the cartridge insert out of the cartridge. 

3. Slide the Top Running Buffer vial into the cartridge insert so that the metal pin on the side of the vial is 
facing out. Press the vial up until it is completely inside the cartridge insert. 

NOTE: The Top Running Buffer vial has metal pins on either side, so no specific orientation is necessary.

4. Slide the cartridge insert back into the cartridge.

Cartridge
Insert

Optical
Window

Cartridge
Inlet



Running CE-SDS Applications page 122

User Guide for Maurice, Maurice C. and Maurice S.

Step 3: Install the Cartridge

1. Open Maurice•s door by touching the metal plate on top of the door. 

NOTE: The indicator light on Maurice•s front panel will blink rapidly as the door disengages.

2. Swing the door open to access the cartridge slot and the reagents and samples platform. The lights on 
either side of the slot will be orange. 
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3. Lift the cartridge and hold it vertically using the finger holds on either side, cartridge inlet down, with 
the CE-SDS label facing you. 

4. Gently insert it into the slot. You•ll feel the alignment groove on the cartridge align inside the slot when 
you insert it.

5. Continue to slide the cartridge into the slot until the locking mechanism engages. The lights on either 
side of the slot will change to blue once the cartridge is installed correctly.
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Step 4: Load Samples and Reagents

1. Place the reagent vials into their respective positions in the sample and reagents platform:

NOTES:  
The two reagent rows in Maurice•s reagent and sample platform are kept at room temperature. 
 
Pressure caps are orange and have a raised, ringed surface. They should only be used in Reagent Row P. 
Use reagent vials with clear screw caps in Row N. 

€ P1 - Conditioning Solution 1 with orange pressure cap

€ P2 - Conditioning Solution 2 with orange pressure cap

€ P3 - DI water with orange pressure cap

€ P4 - Separation Matrix with orange pressure cap

€ P5 - Wash Solution vial with orange pressure cap

€ P6 - Empty vial (air) with orange pressure cap

€ N1 - Wash Solution vial with clear screw cap

€ N2 - Wash Solution vial with clear screw cap

€ N4 - Running Buffer - Bottom with clear screw cap
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2. Depending on what you prepared your samples in, put your 96-well sample plate in the metal plate 
insert or your sample vials in the metal vial insert. 

NOTE: Well A1 on the 96-well plate should be in the top left corner of the insert.

3. Close the instrument door. Maurice locks it automatically. 

Step 5: Create a Batch

1. Launch Compass for iCE.

2. Select the Batch tab. This is where you•ll enter sample/injection information, methods and batch 
parameters. 
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3. To create a batch, make sure Maurice is connected to Compass for iCE. If he isn•t, select Instrument and 
click Connect. Then select your Maurice system and click Connect.

To create a new batch: 

€ On Maurice systems - in the main menu, select File > New Batch > Maurice CE-SDS.

€ On Maurice S. systems - in the main menu, select File > New Batch.

To use an existing batch: In the main menu, select File > Open Batch.

NOTE: If you•re making changes to an existing batch, follow the steps in this section. Otherwise skip to 
•Step 6: Start the BatchŽ on page 133.

4. In the Layout pane, clicking on the vial/plate icon toggles between formats. Select a 96-well plate or 48 
vials depending on what you•re running. 

5. Use your mouse to highlight the well positions for each of your samples, then click Add.



Running CE-SDS Applications page 127

User Guide for Maurice, Maurice C. and Maurice S.

This populates the Injections table:

6. Compass for iCE can monitor the current during a separation for you, stop it if the current drops below 
the minimum value and reinject the sample for you automatically. Reinjections are enabled by default, 
but if you don•t want to use this feature just click the reinject icon to toggle it off. 

NOTES:  
If a sample was reinjected, the injection row will be flagged in the Injections pane in the Run Summary 
screen. See •Injection FlagsŽ on page 158 for more info. 
 
A maximum of 10 reinjections are allowed per batch.
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7. The sample platform is temperature controlled with a default setting of 10 °C. To change the tempera-
ture or turn it off, click the down arrow next to the temperature and select an option. 

NOTE: The two reagent rows are kept at room temperature. 

8. In the Methods pane:

NOTE: There are three default methods. We recommend using the default method parameters for the 
listed samples. Please see the Maurice CE-SDS Application Guide for more information on method optimi-
zation.

a. Click the first cell in the Name column and enter a new method name if needed. 

b. Click the first cell in the Sample Load column, then click then click the selection button [...] to set 
your load profile time (in seconds) and voltage.
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c. Click the first cell in the Separation column then click the selection button [...] to set your separation 
time (in minutes) and voltage.

NOTE: Run your reduced IgG samples and IgG Standard for 25 minutes and the CE-SDS MW Markers for 30 
minutes. Run your non-reduced IgG samples and IgG Standard for 35 minutes. The default separation 
voltage for all sample types is 5750 volts.

9. You can now: 

€ Make updates to the remaining methods by repeating the prior steps.

€ Select a method and click Remove in the upper right corner of the Methods pane to delete it.

€ Click New in the upper right corner of the Methods pane to add a new one if you want to use dif-
ferent methods for different samples. Then just repeat the steps above for the new method.

10. In the Injections pane:

a. To add sample names: Click the Sample ID cell for the injection and type a name.
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b. To assign methods for each injection: Click the Method cell for the injection and select a method 
from the drop down menu. 

€ To add sequential replicate injections: Highlight an injection and click Replicate. A new injec-
tion will be added under the row you selected

€ To add injections at the end of the batch: Click on any sample position in the Layout pane or 
sample injection in the Injection table and click Add. A new injection using the same sample will 
be added to the end of the table. Assign the method if needed. 
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€ To copy and paste injections: Right-click on an injection in the Injection table and select Copy. 
Click on the injection number above where you want to insert the copied injection, right click 
and select Paste. The copied injection will be inserted under the row you selected. 

11. Click on the Notes pane, then click in the notes area and type any information you want to add about 
your batch (optional).

12. You can preset the parameters used to analyze data generated with the batch (optional). We recom-
mend using the default parameters for CE-SDS applications, but if you want to modify parameters:

a. Select Edit from the main menu and click Default Analysis. The following screen will display: 
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b. Change the parameters you want to, then click OK. For detailed information on analysis parameters, 
please refer to •Analysis Settings OverviewŽ on page 244

13. Once all of your sample, method and injection info is entered, select File > Save. Enter any comments 
on the batch if you want, then click Save.

14. Enter a name for your batch then click Save. 
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Step 6: Start the Batch

1. Make sure Maurice is connected to Compass for iCE. If he isn•t, select Instrument and click Connect. 
Then select your Maurice system and click Connect.

2. Click Start to start your batch. 

3. The Start Run box shows you the number of injections and batches remaining on your cartridge. Make 
sure you still have enough injections left before you start the run. If not, prep a new cartridge. 

4. Click in the Results File name box if you want to change the default run file name. Otherwise just leave 
it as is. 

5. If you don•t want to save the file to the default Runs folder, click Browse to select a different location.

6. Enter any run details you•d like in the Comments box (optional).

7. Click Start to start the run.

NOTE: The indicator light on Maurice•s front panel will pulse slowly while he•s running the batch.
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To monitor the progress of your batch, click the Run Summary tab. See Chapter 9, •Run Status• for more 
details. 

To view results, analyze results or change analysis parameters on completed injections while the batch is 
still running, click the Analysis tab. See Chapter 11, •CE-SDS Data Analysis• for more details.
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When your batch is complete, you can view electropherograms for all injections in the Analysis tab, and 
all batch and injection details in the Run Summary tab.

NOTE: If you•d like Maurice to let you know when your run is done, you can set him up to tweet you. Go to 
•Setting Up Maurice Systems to Send TweetsŽ on page 383 for more info.

Post-batch Procedures
When the batch is done: 

1. Open Maurice•s door. The lights on either side of the cartridge slot will be orange as Maurice will have 
already disengaged the cartridge. 

2. Remove your reagent vials and samples and discard.

3. Gently pull out the cartridge making sure the cartridge inlet doesn•t come into contact with any surface.
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NOTE: If you see any separation matrix sticking to the capillary inlet, soak it in DI water for 5 minutes. Then 
wipe it using a lint-free laboratory wipe that's been moistened with DI water.

4. Pull the cartridge insert out.

5. Remove the Top Running Buffer vial and dispose of it according to your institution's safety and waste 
disposal guidelines. 

6. Check the saturation sensor on the back of the cartridge insert. If it's red, you'll need to use a new car-
tridge insert for your next batch. If the saturation sensor isn't red, you can keep using the current car-
tridge insert with that cartridge. 

NOTE: Don't dispose of the cartridge insert unless the saturation sensor is red.

Saturation
Sensor
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If you're at 100 injections, the cartridge is at its limit. Put it in its original packing and discard it along 
with the cartridge insert and the Top Running Buffer vial per your institution's safety and waste disposal 
guidelines. Discard the cleaning vial you've used with that cartridge too.

NOTE: Disposal of cartridges, sample plates and vials depends on the samples you ran. If you aren•t sure 
what your sample origins are, we recommend you dispose of everything in biohazard waste. 

If you've still got injections left and the cartridge will be used again within 2 hours. You can leave 
the cartridge in Maurice. When you're ready to run the next batch, just replace the Top Running Buffer 
vial with a fresh one. 

If you've still got injections left and the cartridge won't be used within 2 hours. Clean and store 
the cartridge:

a. Pipette 1.5 mL of DI water in a new glass reagent vial and close it with an orange pressure cap. 
Place this vial in P3.

b. Insert a Cleaning Vial into the cartridge insert.

c. Slide the cartridge insert back into the cartridge.

d. Insert the cartridge in Maurice.

e. In the Compass main menu, select Instrument and click Cartridge Cleanup. 



Post-batch Procedures page 138

User Guide for Maurice, Maurice C. and Maurice S.

I

f. You•ll get the following message. Click OK. It•ll only take six minutes.

g. Once the cleanup procedure is done, remove the cartridge.

h. Pull the insert from the cartridge.

i. Remove the Cleaning Vial and push the empty insert back into the cartridge. 

NOTE: The cleaning vial is paired with the cartridge and can be used for a maximum of three Cartridge 
Cleanup cycles of that cartridge. Dispose of the cleaning vial when you dispose of the cartridge. Don't use 
it with other cartridges.

j. Put the cartridge back in its protective packaging and store it at room temperature.

!WARNING! SHARPS HAZARD 
The capillary inlet of the cartridge may present a potential sharps hazard. Dispose of used cartridges 
according to your organizations health and safety regulations. 
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!WARNING! BIOHAZARD  
Cartridges, sample plates and vials should be handled by procedures recommended in 
the CDC/NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). 
The manual is available from the U.S. Government Printing Office or online at http://
www.cdc.gov/biosafety/publications/bmbl5/.  
 
Depending on the samples used, the cartridges, plates and vials may constitute a chemi-
cal or a biohazard. Dispose of the cartridges, plates and vials in accordance with good lab-
oratory practices and local, state/provincial, or national environmental and health 
regulations. Read and understand the Safety Data Sheets (SDSs) provided by the manu-
facturers of the chemicals in the waste content before you store, handle, or dispose of 
chemical waste.

Checking Your Data
Compass for iCE detects your sample proteins, CE-SDS MW Markers and Internal Standard peaks and reports 
results automatically. But, we always recommend you review your data using the steps in this section as a 
good general practice to make sure your results are accurate. If you see a data warning in the Experiment 
pane, these steps will also help you identify and correct any issues. 

Step 1: Check Your Internal Standard

To make sure your Internal Standard is identified correctly:

1. Go to the Analysis screen and open your run (if it isn•t already open).

2. Click Standards in the View bar. 

3. Click the Single View icon in the View bar.

4. Click Injection 1 in the Experiment pane.
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5. Check that your Internal Standard in the electropherogram has been correctly identified. It•ll be labeled 
Std 1 and will have a green vertical line running through it. The Internal Standard is also identified with 
an S in the Peaks table. 

6. If your Internal Standard isn•t identified correctly, here•s how to manually correct it: 

To set an unidentified peak as the Internal Standard: Right-click the peak in the electropherogram 
or Peaks table and select Force Standard. Compass will assign that peak as the Internal Standard. 
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A lock icon indicating the Internal Standard was set manually will display next to the peak in the Peaks 
table and a check mark will appear next to the injection in the Experiment pane to show a manual cor-
rection was made.
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NOTE: To remove an Internal Standard peak assignment that was made manually, right click on the peak 
in the electropherogram or Peaks table and click Clear. To clear all the manual settings for the injection, 
click Clear All.

If an incorrect peak is identified as the Internal Standard: Right-click the peak in the electrophero-
gram or Peaks table and select Not a Standard. 

An S with a red slash through it will appear next to the incorrectly assigned peak in the Peaks table and 
a check mark will appear next to the injection in the Experiment pane to show a manual correction was 
made.



Checking Your Data page 143

User Guide for Maurice, Maurice C. and Maurice S.

7. Repeat the previous steps for all other injections to make sure your Internal Standard is identified cor-
rectly.

Step 2: Set Your Molecular Weight (MW) Markers

NOTE: You•ll only need to do this if you ran the CE-SDS MW Markers. If you didn•t, you can skip to the next 
section.

Compass reports the relative migration time (RMT) of your sample in the Peaks table. If you also want to 
know the relative molecular weight of your sample, you can run the CE-SDS MW Markers as one of your 
injections.

You'll see these sizing markers when you run the CE-SDS MW Markers: 10, 20, 33, 55, 103, 178, and 240 kDa. 

To get MW data:

1. Click Samples in the View bar. 

2. Select Edit from the main menu and click Analysis. In the Analysis window, select Markers in the left 
sidebar. Then click the Markers Injection drop down menu to select the injection you ran your CE-SDS 
MW Markers in. 
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3. The default Maurice CE-SDS MW Markers molecular weights and relative migration time (RMT) values 
are already populated in the table. If you•d like to use these values, skip to the next step. If you•re using 
different markers, click in the MW and RMT cells to type new values, click a row and select Remove to 
delete, or click Add to add a new one.
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4. Click OK to close the Analysis window. Compass will automatically assign the molecular weights to your 
makers and label them Mkr. A MW (kDa) column will also now display in the Peaks table. 

NOTE: The Mkr 10 peak is also the Internal Standard in every sample. 

5. It's always a good idea to verify that all your CE-SDS MW Markers are identified correctly. Here•s how to 
manually correct them:

To set an unidentified peak as a MW Marker: Right-click the peak in the electropherogram or Peaks 
table and select Add Peak. Compass will assign that peak as a MW Marker, and correctly reassign the 
remaining marker peaks. 
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A check mark will appear next to the injection in the Experiment pane to show a manual correction was 
made.

NOTE: To remove MW Marker peak assignments that were made manually, right click on the peak in the 
electropherogram or Peaks table and click Clear.

If an incorrect peak is identified as a MW Marker: Right-click the peak in the electropherogram or 
Peaks table and select Remove Peak. Compass should correctly reassign the remaining peaks as mark-
ers and update the Peaks table.
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A check mark will appear next to the injection in the Experiment pane to show a manual correction was 
made.

Step 3: Checking Sample Peaks

All detected peaks will be labeled automatically with the RMT (default) or apparent MW (if the CE-SDS MW 
Markers were run).

To make sure your sample proteins are identified correctly:

1. Click Samples in the View bar. 

2. Click the Single View icon in the View bar.
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3. Click Injection 1 in the Experiment pane. 

4. If your sample peaks aren•t identified correctly, here•s how to manually correct them: 

If a peak is incorrectly identified as a sample peak: Right-click the peak in the electropherogram or 
Peaks table and select Remove Peak. Compass will no longer identify it as a sample peak in the electro-
pherogram and the peak data will be removed in the results table. 

A check mark will appear next to the injection in the Experiment pane to indicate a manual correction 
was made.
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To identify a peak as a sample peak: Right-click the peak in the electropherogram or Peaks table and 
select Add Peak. Compass will calculate and display the results for the peak in the results table and 
identify the peak in the electropherogram. 

A check mark will appear next to the injection in the Experiment pane to indicate a manual correction 
was made.
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NOTE: To remove sample peak assignments that were made manually and go back to the original peak 
data, right-click the peak in the electropherogram and select Clear.

5. Repeat the previous steps for the remaining injections to make sure all sample peaks are correctly iden-
tified.

Step 4: Assigning Peak Names

Compass can also optionally identify and automatically name sample peaks using user-specified peak name 
settings. For more information on how to do this, see •Peak Names SettingsŽ on page 354.


